
http://www.facebook.com/share.php?u=http://www.informIT.com/title/9780136886624
http://twitter.com/?status=RT: download a free sample chapter http://www.informit.com/title/9780136886624
https://plusone.google.com/share?url=http://www.informit.com/title/9780136886624
http://www.linkedin.com/shareArticle?mini=true&url=http://www.informit.com/title/9780136886624
http://www.stumbleupon.com/submit?url=http://www.informit.com/title/9780136886624/Free-Sample-Chapter


Apple Pro Training Series

Logic Pro X 10.5
David Nahmani



Logic Pro X 10.5 – Apple Pro Training Series: Professional Music Production
David Nahmani
Copyright © 2021 by David Nahmani. All Rights Reserved.

Peachpit Press
www.peachpit.com
Peachpit Press is an imprint of Pearson Education, Inc.
To report errors, please send a note to errata@peachpit.com.
 
Apple Series Editor: Laura Norman
Editor: Robyn G. Thomas
Senior Production Editor: Tracey Croom 
Production Coordinator: Maureen Forys, Happenstance Type-O-Rama
Technical Editor: John Moores
Copy Editor: Elizabeth Welch
Proofreader: Scout Festa
Compositor: Cody Gates, Happenstance Type-O-Rama
Indexer: Valerie Perry
Cover Illustration: Von Glitschka
Cover Production: Cody Gates, Happenstance Type-O-Rama

Fast Jam © 2020, composed and produced by David Nahmani. All rights reserved.
Sampler Feast © 2020, composed and produced by David Nahmani. All rights reserved.
Future Nostalgia © 2020, composed and produced by David Nahmani. All rights reserved.
Drum Samples, performed and recorded by Jon Mattox. All rights reserved. For more on Jon Mattox,  
visit https://jonmattox.com.
Moments (Pop Mix) (by Darude featuring Sebastian Rejman) © 2016, music and lyrics by V. Virtanen, S. Rejman, and J. Ehnqvist. 
All rights reserved. For more on Darude, visit www.darude.com, www.facebook.com/Darude, www.instagram.com/Darude,  
www.twitter.com/Darudevil, www.youtube.com/Darude, and www.twitch.tv/Darude.
Lights On © 2018, composed and produced by Distant Cousins. All rights reserved. For more on Distant Cousins,  
visit www.distantcousinsofficial.com, www.facebook.com/DistantCousinsOfficial, www.instagram.com/distantcousinsofficial, and 
www.cousinsintheclassroom.com.
Drum samples in this book were used with permission of the three artists who contributed: Jon Mattox, Distant Cousins, and Darude.
The projects and footage supplied with this book may only be used for educational purposes in association with the lessons included. 
Any other use, including but not limited to incorporating footage into another project, duplicating or distributing footage, is expressly 
forbidden and requires explicit permission from the copyright holders listed above.

Notice of Rights
Printed in the United States of America. This publication is protected by copyright, and permission should be obtained from the 
publisher prior to any prohibited reproduction, storage in a retrieval system, or transmission in any form or by any means, elec-
tronic, mechanical, photocopying, recording, or otherwise. For information regarding permissions, request forms and the appropri-
ate contacts within the Pearson Education Global Rights & Permissions department, please visit www.pearson.com/permissions.

Notice of Liability 
The information in this book is distributed on an “As Is” basis, without warranty. While every precaution has been taken in the 
preparation of the book, neither the author nor Peachpit shall have any liability to any person or entity with respect to any loss or 
damage caused or alleged to be caused directly or indirectly by the instructions contained in this book or by the computer software 
and hardware products described in it.

Trademarks 
Unless otherwise indicated herein, any third party trademarks that may appear in this work are the property of their respective own-
ers and any references to third party trademarks, logos or other trade dress are for demonstrative or descriptive purposes only. Such 
references are not intended to imply any sponsorship, endorsement, authorization, or promotion of Pearson Education, Inc. products 
by the owners of such marks, or any relationship between the owner and Pearson Education, Inc., or its affiliates, authors, licensees 
or distributors.

ISBN 13: 978-0-13-688662-4 
ISBN 10: 0-13-688662-0 

ScoutAutomatedPrintCode

http://www.peachpit.com
mailto:errata@peachpit.com
https://jonmattox.com
http://www.darude.com
http://www.facebook.com/Darude
http://www.instagram.com/Darude
http://www.twitter.com/Darudevil
http://www.youtube.com/Darude
http://www.twitch.tv/Darude
http://www.distantcousinsofficial.com
http://www.facebook.com/DistantCousinsOfficial
http://www.instagram.com/distantcousinsofficial
http://www.cousinsintheclassroom.com
http://www.pearson.com/permissions


Acknowledgments I would like to express my thanks to my wife Nathalie 
and to my sons, Liam and Dylan, for their support and encouragement; and to 
my editors, Robyn Thomas, John Moores, and Laura Norman, for being by my 
side and enabling me to write the best book I could write.

My deepest gratitude to the artists and producers who agreed to provide their 
media, songs, and Logic projects for this book: Distant Cousins, for their song 
“Lights On”; Darude, for his song “Moments”; and Jon Mattox, for providing 
drum samples. 





Contents at a Glance

v

 Getting Started . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xi

Lesson 1 Producing Music with Logic Now!  . . . . . . . . . . . . . . . . . . . . . . . . 1

Lesson 2 Producing a Virtual Drum Track  . . . . . . . . . . . . . . . . . . . . . . . .  81

Lesson 3 Using Effect and Instrument Plug-ins . . . . . . . . . . . . . . . . . . . . 129

Lesson 4 Recording Audio and MIDI . . . . . . . . . . . . . . . . . . . . . . . . . . . . 171

Lesson 5 Sampling Audio  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 237

Lesson 6 Performing with MIDI Controllers and Logic Remote . . . . . 297

Lesson 7 Creating Content  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 335

Lesson 8 Integrating Your Workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 379

Lesson 9 Editing Pitch and Time . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 393

Lesson 10 Mixing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 431

Appendix Keyboard Shortcuts (Default for U.S. Keyboard) . . . . . . . . . . 489

 Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 497



Table of Contents

vi

 Getting Started . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xi

Lesson 1 Producing Music with Logic Now! . . . . . . . . . . . . . . 1
 Creating a Logic Pro X Project . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
 Perform in Real Time with Live Loops . . . . . . . . . . . . . . . . . . . . . 7
 Exploring the Interface . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
 Navigating and Building the Project  . . . . . . . . . . . . . . . . . . . . . . 33
 Editing Regions in the Workspace . . . . . . . . . . . . . . . . . . . . . . . . 53
 Mixing the Song  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67
 Mixing Down to a Stereo File . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
 Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

Lesson 2 Producing a Virtual Drum Track . . . . . . . . . . . . . . 81
 Creating a Drummer Track . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82
 Arranging the Drum Track . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 95
 Customizing the Drum Kit . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 106
 Working with an Electronic Drummer . . . . . . . . . . . . . . . . . . . 114
 Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 127

Lesson 3 Using Effect and Instrument Plug-ins  . . . . . . . . . 129
 Inserting Plug-ins . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 129
 Loading and Editing Patches . . . . . . . . . . . . . . . . . . . . . . . . . . . . 145
 Setting Up Parallel Processing . . . . . . . . . . . . . . . . . . . . . . . . . . . 150
 Moving and Copying Plug-ins  . . . . . . . . . . . . . . . . . . . . . . . . . . 161
 Saving User Patches and Plug-in Settings . . . . . . . . . . . . . . . . . 166
 Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 169



Contents  vii

Lesson 4 Recording Audio and MIDI . . . . . . . . . . . . . . . . . . 171
 Setting Up Digital Audio Recording  . . . . . . . . . . . . . . . . . . . . . 171
 Recording Audio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 178
 Recording Additional Takes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 191
 Punching In and Out . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197
 Deleting Unused Audio Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . 206
 Recording MIDI  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 209
 Correcting the Timing of a MIDI Recording . . . . . . . . . . . . . . 215
 Recording Over a MIDI Region . . . . . . . . . . . . . . . . . . . . . . . . . 218
 Recording Into Live Loop Cells  . . . . . . . . . . . . . . . . . . . . . . . . . 222
 Recording Without a Metronome  . . . . . . . . . . . . . . . . . . . . . . . 231
 Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 235

Lesson 5 Sampling Audio . . . . . . . . . . . . . . . . . . . . . . . . . . . . 237
 Sampling Single Notes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 238
 Sampling and Slicing Drums . . . . . . . . . . . . . . . . . . . . . . . . . . . . 263
 Transposing a Sample While  

Keeping It Synced to the Project Tempo . . . . . . . . . . . . . . . . . . 270
 Chopping Loops in a Take Folder  . . . . . . . . . . . . . . . . . . . . . . . 273
 Creating Vocal Chops . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 286
 Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 295

Lesson 6  Performing with MIDI  
Controllers and Logic Remote . . . . . . . . . . . . . . . . 297

 Assigning Hardware Controllers  . . . . . . . . . . . . . . . . . . . . . . . . 297
 Mapping Smart Controls to Plug-ins . . . . . . . . . . . . . . . . . . . . . 306
 Controlling Logic from an iPad Using Logic Remote . . . . . . . 312
 Performing Live DJ Effects with Remix FX  . . . . . . . . . . . . . . . 327
 Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 333

Lesson 7 Creating Content . . . . . . . . . . . . . . . . . . . . . . . . . . . 335
 Step Sequencing. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 336
 Programming MIDI in the Piano Roll . . . . . . . . . . . . . . . . . . . . 351
 Editing Audio Regions and Adding Fades  . . . . . . . . . . . . . . . . 364
 Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 376



viii   Contents

Lesson 8 Integrating Your Workflow . . . . . . . . . . . . . . . . . . 379
 Importing Audio into Drum Machine Designer . . . . . . . . . . . 380
 Populating Scenes in the Live Loops Grid  . . . . . . . . . . . . . . . . 383
 Copying or Recording Scenes in the Tracks View . . . . . . . . . . 387
 Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 391

Lesson 9 Editing Pitch and Time . . . . . . . . . . . . . . . . . . . . . . 393
 Setting a Project Tempo by  

Detecting the Tempo of a Recording . . . . . . . . . . . . . . . . . . . . . 394
 Matching an Audio File to the Project Key and Tempo . . . . . 399
 Creating Tempo Changes and Tempo Curves  . . . . . . . . . . . . . 402
 Making One Track Follow the Groove of Another Track . . . . 407
 Changing the Playback Pitch and Speed with Varispeed . . . . 410
 Editing the Timing of an Audio Region  . . . . . . . . . . . . . . . . . . 413
 Tuning Vocal Recordings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 423
 Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 429

Lesson 10 Mixing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 431
 Organizing Windows and Tracks . . . . . . . . . . . . . . . . . . . . . . . . 432
 Adjusting Volume, Pan, EQ, and Reverb . . . . . . . . . . . . . . . . . . 441
 Processing Lead Vocals  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 453
 Automating Mixer Parameters . . . . . . . . . . . . . . . . . . . . . . . . . . 468
 Quick Mastering . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 478
 Exporting the Mix to a Stereo Audio File . . . . . . . . . . . . . . . . . 483
 Using a Few Tips and Tricks . . . . . . . . . . . . . . . . . . . . . . . . . . . . 485
 Key Commands . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 487

Appendix  Keyboard Shortcuts  
(Default for U.S. Keyboard) . . . . . . . . . . . . . . . . . . 489

 Panes and Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 489
 General . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 490
 Navigation and Playback . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 490
 Zooming . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 491
 Channel Strip, Track, and Region Operations  . . . . . . . . . . . . . 492



Contents  ix

 Live Loops  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 493
 Library  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 494
 Project Audio Browser . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 494
 Step Sequencer . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 494
 Piano Roll Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 494
 macOS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 495

Index  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 497





xi

Welcome to the official Apple Pro Training Series course for 

Logic Pro X 10.5. This book is a comprehensive introduction to profes-

sional music production with Logic Pro X 10.5. It uses real-world music 

and hands-on exercises to teach you how to record, edit, arrange, mix, 

produce, and polish audio and MIDI files in a professional workflow. So 

let’s get started!

The Methodology

This book takes a hands-on approach to learning the software, so you’ll 
be working through the project files and media you download after regis-
tering the book at www.peachpit.com/apts.logicprox10.5. It’s divided into 
lessons that introduce the interface elements and ways of working with 
them, building progressively until you can comfortably grasp the entire 
application and its standard workflows.

Each lesson in this book is designed to support the concepts learned in the 
preceding lesson, and first-time readers should go through the book from start 
to finish. However, each lesson is self-contained, so when you need to review a 
topic, you can quickly jump to any lesson.

The book is designed to guide you through the music production process as it 
teaches Logic, and it is organized in 10 lessons. 

Lesson 1 starts you with an overview of the entire process. You’ll become 
familiar with the interface and the various ways to navigate a project; use 
Apple Loops to build a song from scratch; and then arrange, mix, and export 
the song to an MP3 file.

Getting Started

xi

http://www.peachpit.com/apts.logicprox10.5
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Lesson 2 focuses on drum tracks, the foundation of your song. You’ll use Drummer 
to generate virtual drumbeat performances triggering acoustic and electronic drum 
instruments. 

In Lesson 3 you will explore effect and instrument plug-ins, use the Library to load 
patches and presets, and save your own plug-in settings. 

Lesson 4 dives deeper into typical situations that you may encounter when recording 
audio sources, such as microphones, guitars, and MIDI controllers. You’ll record both in 
the linear Tracks view editor and in the Live Loops grid. 

You will use the new Quick Sampler instrument plug-in in Lesson 5 to turn a voice into a 
synthesizer pad, record your own handclap sample, create vocal chop effects, and sample a 
bass sound from a loop to create your own bass line.

Lesson 6 shows you how to connect MIDI controllers to Logic to trigger loops, navigate 
the project, or adjust plug-in parameters. You will explore the free Logic Remote app (for 
iPad and iPhone) to control Logic from your multi-touch screen and use the iPad’s built-
in gyroscope to modulate effects. 

To create content in Lesson 7, you’ll program MIDI in the Piano Roll, create drumbeats 
and step automation in Logic’s new Step Sequencer, edit Audio regions, and add fades and 
turntable start and stop effects.

Lesson 8 is a brief overview of workflow that integrates multiple features—learned in the 
previous lessons—into a complete music production process. You’ll start by building your 
own drum instrument with samples, program a drumbeat in Step Sequencer, combine it 
with recordings and Apple Loops in the Live Loops grid, and record your Live Loops per-
formance into the Tracks view to build an arrangement.

Lesson 9 explores various ways to edit the pitch and time of your recordings, using Smart 
Tempo to ensure that all your audio files play at the same tempo; creating custom tempo 
curves; using groove tracks and Varispeed; time-stretching audio; and tuning vocals. 

You’ll study the end processes of music production in Lesson 10: mixing, automating, and 
mastering using track stacks, EQ, compressor, limiter, and delay and reverb plug-ins. You 
will export your final mix as a stereo audio file.

Appendix A lists a wealth of useful keyboard shortcuts to help speed up your workflow.
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System Requirements

Before using Apple Pro Training Series: Logic Pro X 10.5, you should have a working 
knowledge of your Mac and the macOS operating system. Make sure that you know how 
to use the mouse or trackpad and standard menus and commands, and how to open, save, 
and close files. If you need to review these techniques, see the printed or online documen-
tation included with your system.

Logic Pro X and the lessons in this book require the following system resources:

 ▶ macOS 10.14.6 or later

 ▶ Minimum 6 GB of disk space (up to 72 GB of disk space for the full Sound Library 
installation)

 ▶ High-speed internet connection for installation

 ▶ MIDI keyboard (optional but recommended to play and record software instruments) 
connected via USB or via a compatible MIDI interface 

 ▶ (optional) iPhone or iPad with iOS 13.1 or later for controlling Logic using the 
Logic Remote iPad app as shown in Lesson 6

Preparing Your Logic Workstation

The exercises in this book require that you install Logic Pro X along with the entire Apple 
Sound Library (including the Legacy and Compatibility content). If you have not yet 
installed Logic, you may purchase it from the App Store. When your purchase is com-
pleted, Logic Pro X will automatically be installed on your hard drive, and you will be 
prompted to install the Apple Sound Library.

Some of the instructions and descriptions in this book may vary slightly, depending on 
the sounds you have installed.

When you first open Logic Pro X, the app will automatically download and install the 
essential content. If you get an alert offering to download more sounds, continue to down-
load and install all the sounds. 

To make sure the complete Apple Sound Library is installed on your Mac, choose Logic 
Pro X > Sound Library > Open Sound Library Manager, and click Select All Uninstalled. 
Make sure the Legacy and Compatibility content is selected. Then, click Install.
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NOTE ▶ If you choose not to download the entire Logic sound library, you may be 
unable to find some of the media needed in the exercises. Missing media will appear 
dimmed with a down arrow icon. Click the down arrow icon to download that media.

Online Content

Your purchase of Apple Pro Training Series: Logic Pro X 10.5 includes online materials pro-
vided by way of your Account page at www.peachpit.com. These include the following.

Lesson files

The downloadable content for Apple Pro Training Series: Logic Pro X 10.5 includes the 
project files you will use for each lesson, as well as media files that contain the audio and 
MIDI content you will need for each exercise. After you save the files to your hard disk, 
each lesson will instruct you in their use. To download the lesson files, you will need to 
follow the instructions below. 

Free Web Edition

The Web Edition is a free online version of the book that is included with your purchase. 
Your Web Edition can be accessed on our site from any device with a connection to the 
Internet.

http://www.peachpit.com
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Accessing the lesson files and Web Edition from www.peachpit.com

1 Go to www.peachpit.com/apts.logicprox10.5.

2 Sign in or create a new account.

3 Click Register.

4 Answer the question as proof of purchase.

The lesson files can be accessed from the Registered Products tab on your Account page. 

5 Click the Access Bonus Content link below the title of your product to proceed to the 
download page. 

6 Click the lesson file link(s) to download them to your computer. 

The Web Edition can be accessed from the Digital Purchases tab on your Account page. 

7 Click the Launch link to access the product.

NOTE ▶ If you’ve enabled the Desktop and your Document folder to sync to iCloud, 
you are strongly advised not to copy your lesson files to your Desktop. Choose 
another location, such as the Logic folder within your Music folder.

8 After downloading the file to your Mac desktop, you’ll need to unzip the file or 
mount the disk image to access a folder titled Logic Book Projects, which you will 
save or move to your Mac desktop. Each lesson explains which files to open for that 
lesson’s exercises.

NOTE ▶ If you purchased a digital product directly from www.peachpit.com, your 
product will already be registered. However, you still need to follow the registration 
steps and answer the proof-of-purchase question before the Access Bonus Content 
link will appear under the product on your Registered Products tab.

Using Default Preferences and Key Commands, and Selecting the 
Advanced Tools

All the instructions and descriptions in this book assume that you are using the default 
preferences (unless instructed to change them). At the beginning of Lesson 1, you will be 
instructed how to show advanced tools and select all additional options.

http://www.peachpit.com
http://www.peachpit.com/apts.logicprox10.5
http://www.peachpit.com
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If you have changed some of your Logic Pro X preferences, you may not see the same 
results as described in the exercises. To make sure that you can follow along with this 
book, it’s best to revert to the initial set of Logic preferences before you start the lessons. 
Keep in mind, however, that when you initialize preferences, you lose your custom set-
tings, and later you may want to reset your favorite preferences manually.

1 Choose Logic Pro X > Preferences > Advanced Tools.

2 Select Show Advanced Tools.

3 Click the Enable All button to select all additional options, and then close the prefer-
ences window.

4 Choose Logic Pro X > Preferences > Reset All Preferences Except Key Commands.

A confirmation message appears.

5 Click Initialize.

Your preferences are initialized to their default states.

NOTE ▶ After initializing Preferences, you may need to re-select the desired audio 
interface: choose Logic Pro X > Preferences > Audio, choose your audio interface 
from the Output Device and Input Device pop-up menus, and make sure Core Audio 
is enabled. The first time you create a new audio track, in the New Track dialog, make 
sure Output is set to Output 1 + 2.

Using the U.S. Key Command Preset

This book assumes that you are using the default initialized key command preset for a 
U.S. keyboard. If you have customized your key commands, you may find that some of 
the key commands in your Logic installation do not function as they are described in this 
book.

If at any point you find that the key commands don’t respond as described in this book, 
make sure the U.S. key command preset is selected on your Mac by choosing Logic Pro X > 
Key Commands > Presets > U.S.
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Screen Resolution

Depending on your display resolution, some of the project files may appear different on 
your screen than they do in the book. When you open a project, if you can’t see the whole 
main window, move the window until you can see the three window controls at the left of 
the title bar and Option-click the Zoom button (the green button, third from the left) to 
fit the window to the screen.

When using a small display, you may also have to zoom or scroll more often than 
instructed in the book when performing some of the exercise steps. In some cases, you 
may have to temporarily resize or close an area of the main window to complete an action 
in another area.

About the Apple Pro Training Series

Apple Pro Training Series: Logic Pro X 10.5 is a self-paced learning tool and Apple’s official 
guide for Logic Pro X. Books in this series also include downloadable lesson files and an 
online version of the book. The lessons are designed to let you learn at your own pace.

For a complete list of Apple Pro Training Series books, visit www.peachpit.com/apple.

Resources

Apple Pro Training Series: Logic Pro X 10.5 is not intended as a comprehensive reference 
manual, nor does it replace the documentation that comes with the application. For com-
prehensive information about program features, refer to the following resources:

 ▶ Logic Pro Help, accessed through the Logic Pro X Help menu, contains a description 
of most features. Other documents available in the Help menu can also be valuable 
resources.

 ▶ The Apple websites www.apple.com/logic-pro/ and www.apple.com/support/logicpro/.

 ▶ The official Logic Pro release notes: https://support.apple.com/en-us/HT203718/.

 ▶ The Logic Pro Help website, an online community of Logic users moderated by the 
author of this book, David Nahmani: www.logicprohelp.com/forum.

 ▶ For additional help with accessing the lesson files, you may send email queries to 
ask@peachpit.com.

http://www.peachpit.com/apple
http://www.apple.com/logic-pro/
http://www.apple.com/support/logicpro/
https://support.apple.com/en-us/HT203718/
http://www.logicprohelp.com/forum
mailto:ask@peachpit.com


 Lesson Files None

 Time This lesson takes approximately 150 minutes to complete.

 Goals Perform scene triggering in the Live Loops grid

  Produce a one-minute instrumental piece using prerecorded media

  Explore the Logic Pro X main window interface

  Navigate and zoom the workspace

  Move, copy, loop, trim, and transpose regions in the workspace

  Mix down and export the project 

1
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Shortly after the first analog tape recorders appeared around 1935, 

composers started using the recording medium as a compositional 

tool—manipulating the audio playback using reverberation and echo; 

using voltage control devices that changed the tape speed and thus 

altered playback speed and pitch; and using punch recording to splice 

different sounds together. Throughout the following decades, electro-

acoustic composers—and later pioneering electronic musicians—fasci-

nated by the new unique sounds they could come up with, continued 

exploring audio transformation techniques involving recording devices 

to stray away from the classic acoustic instrument sounds of compos-

ers from past centuries. 

In 1988, Roger Linn designed the AKAI MPC60, which quickly became the 
most legendary sampler and had a major impact on hip-hop music. The iconic 
MIDI sampler made it easy to trigger patches by finger drumming on its built-in 
square pads, while recording the performance onto its built-in sequencer. Today, 
you would be hard-pressed to find a music genre where sampling isn’t used.

In this lesson, you will explore Quick Sampler, a new Logic Pro X software 
instrument plug-in. You will import a finger snap and record a hand clap, and 
then turn a sustained vocal note into a pad synthesizer sound. You will slice 
a drum loop, shortening the volume envelope of the individual slices, and 
add a gritty filter to give it a low-fidelity sound. You’ll splice loops together to 
combine notes from different instruments into a composite melody, creating 
an exhilarating rhythmic sound collage. Finally, you will edit samples into an 
effect called vocal chops.

Sampling Audio
Lesson 5

237
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Always consider the source of your sampling, and if any of that material is copyrighted, 
make sure you thoroughly research sample clearance. Two easy ways to avoid worrying 
about potential legal issues are to sample your own instruments or noises around you, or 
to sample the royalty-free Apple Sound Library content that you downloaded along with 
Logic Pro X (such as software instruments or Apple Loops). 

Sampling Single Notes

The easiest way to use samples in your productions is to import or record a single note 
into Quick Sampler and then trigger that single note from your MIDI keyboard. In Quick 
Sampler, you can modulate the sample’s pitch to give it a vibrato effect, adjust the volume 
envelope, and loop a section of the sample so that you can sustain its sound.

Importing Audio in Quick Sampler and Selecting a Mode

In this exercise, you will use an Apple Loop of finger snaps to create a Quick Sampler 
instrument so that you can trigger the audio file using your MIDI controller keyboard. To 
get started with a rhythmic reference, you’ll first import a loop to create a drum track.

1 Choose File > New (or press Command-N).

An empty project is created, and the New Track dialog opens.

2 In the New Track dialog, select Audio, and click Create (or press Return). 

3 Open the Loop Browser, find Throwback Funk Beat 01, and drag it to the audio track 
at bar 1. 

4 In the Region inspector, click the Loop checkbox (or press L). 

In the workspace, the audio region is looped throughout the project. Now let’s create a 
new track for Quick Sampler.

5 At the top of the track headers, click the + button (or press Command-Option-N). 
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6 In the New Track dialog, choose Software Instrument, make sure the Instrument pop-up 
menu is set to Empty Channel Strip, and click Create (or press Return).

7 Click the Instrument slot, and choose Quick Sampler (Single Sample).

8 In the Loop Browser, search for bounce snap.

9 Drag Lets Bounce Snaps to the waveform display in Quick Sampler.

In the waveform display, two areas appear (Original and Optimized).

10 Drop the file onto Original.

The audio file is imported into Quick Sampler, and its waveform is displayed. Below 
the waveform display on the left, the root key is C3. 
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 You will trigger samples using specific note pitches throughout this lesson. If 
you need to see incoming MIDI note pitches in the MIDI input activity monitor, click 
the small arrow to the right in the LCD display and choose Custom.

11 Play a C3 on your keyboard. 

In Classic mode, the sample plays back while you hold down the key on your key-
board and stops playing when you release the key. Play a C3, and hold down the key 
for a while. The audio file starts with silence and contains four finger snaps. To turn it 
into a playable instrument, in the next exercise you will adjust the start and end mark-
ers so that a C3 note immediately triggers a single finger snap.

12 Play notes other than C3 on your keyboard. 

The sample is transposed chromatically across the keyboard, according to the pitch of 
the note you play. Higher pitches make the sample play back faster, and lower pitches 
make it slower, much like classic samplers, and also like the results you’d get from 
manipulating the speed of analog tape or a turntable. You will change that behavior 
for other samples later. For this finger snap sample, you’ll play only C3 notes to trig-
ger the sample at its original speed and pitch.

To avoid having to hold down the key for the whole duration of the sample, you will 
use the One Shot mode. 

13 Click One Shot.

14 Play a C3. 

In One Shot mode, the sample plays back from the start marker to the end marker, 
even if you release the key earlier. This mode is adapted for drum sounds, as you can 
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trigger drum hits with pads or drum controllers that send very short notes, and still 
play the full duration of the drum sample. 

 To stop a sample from playing back in One Shot mode, turn the Quick 
Sampler plug-in off and on, or press the Space bar twice to start and stop playback. 

You have created your first sampler instrument with a finger snap sample and selected the 
One Shot mode. You are now ready to start editing the portion of the sample you want to 
play back in the waveform display.

Editing Markers in the Waveform Display 

When editing a drum sample, it’s crucial to make sure the sample starts playing exactly 
when you trigger it. You will now use the waveform display in Quick Sampler to precisely 
adjust the start and end marker locations, making sure only the fourth finger snap on the 
waveform is triggered. Don’t worry about finding the perfect position right away. You will 
later zoom in to readjust the start marker position with more precision.

1 In the waveform display, drag the start marker to beginning of the last finger snap.

Below the waveform display, parameters and values related to the current action are 
displayed. 

2 Play a C3. 

This time only the fourth finger snap plays. 
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3 Drag the end marker a little closer to the end of the waveform. 

You will now zoom in on the waveform between the start and end marker. 

4 At the upper right of the waveform display, click the Zoom horizontal button. 

The zoom level is optimized to show the area between the sample start and end mark-
ers. To help positioning the start marker exactly at the beginning of the finger snap 
sound, you can make the markers snap to transients.

5 At the upper right of the waveform display, click the Snap pop-up menu and choose 
Transient+Note. 
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6 Drag the start marker toward the beginning of the waveform. 

The start marker snaps precisely to the first transient on the waveform.

7 Play a C3. 

The sample is triggered right away. Your sampler instrument is now ready to be played!

Adjusting the positions of sample start and end markers lets you determine exactly which 
portion of an audio file you want to trigger when playing your keyboard, and it represents 
the foundation of creating a quality sampler instrument. Using Quick Sampler’s zoom and 
snap functions, you were able to get the job done efficiently and can now focus on the 
performance.

Recording a MIDI Region to Trigger Samples 

You will now put the recording chops you acquired in the previous lesson to good use and 
record a very simple finger snapping performance. You will play a finger snap on the sec-
ond and fourth beat of each bar throughout the first five bars of this project to double the 
snare in the drum loop on Track 1. Let’s open the Piano Roll to see the notes you record.

1 In the control bar, click the Editors button (or press P) to open the Piano Roll.

Regions recorded on a track are assigned the track name, so it’s always a good idea to 
give your track a descriptive name before you start recording. 



244   Sampling Audio

2 In the Inst 1 track header, double-click the track name, and then enter Snaps. 

When using only Apple Loops and MIDI regions, as is the case so far in this project, 
don’t hesitate to lower the tempo as needed to make it easier to perform what you’re 
recording. 

3 In the LCD display, lower the tempo down to 107 bpm. 

4 In the control bar, click the Record button (or press R).

You get a four-beat metronome count-in, the playhead reaches bar 1, and the drum 
loop starts playing back. 

5 Play a C3 on beats 2 and 4 of every bar until the playhead reaches bar 5.

6 In the control bar, click the Stop button (or press the Space bar).

Recording stops, and you have a four-bar green MIDI region on the Inst 1 track. To 
make the rhythm track, you’ll quantize your recording. If you’re unhappy with your 
performance, choose Edit > Undo Recording (or press Command-Z) and try again!
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7 In the Region inspector, click the Quantize pop-up menu, and choose 1/4 Note.

In the Piano Roll, the notes snap to the nearest beat. 

8 Listen to your recording. 

The finger snaps double the snare drum, bringing energy and a human character to 
the beat.

Modulating the Sample’s Pitch

To make the snaps a bit more human sounding, you will now modulate their pitch. In 
Quick Sampler, you’ll use a low-frequency oscillator (LFO) to generate a random signal 
and route it to the pitch parameter so that each note triggers the finger snaps sample at a 
slightly different pitch. 

Now that you have a MIDI region on the Snaps track to trigger your samples, you can 
click the play button in the Piano Roll to cycle through the MIDI region in Solo mode, 
allowing you to give your full attention to the sample’s sound while you adjust the param-
eters in Quick Sampler.
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1 In the Piano Roll, click the Play button.

Cycle mode and Solo mode are on, and the MIDI region plays back. In Quick Sam-
pler, you will route LFO 1 to the pitch. 

2 In the lower section of Quick Sampler, click the Mod Matrix tab. 

The Mod Matrix opens, and you can assign up to four routings. You could choose 
a controller such as the modulation wheel as the source and the pitch as a target, to 
control the pitch with your modulation wheel. However, in order to create an auto-
matic random pitch modulation, you’ll route an LFO to the pitch, and then set the 
LFO to produce a random control signal. 

3 On the first matrix, click the Source pop-up menu and choose LFO 1. 

4 Click the Target pop-up menu and choose Pitch. 

To clearly hear the modulation you’re routing, you can exaggerate the amount of 
modulation for now. Once you are satisfied that you’ve successfully set up your mod-
ulation routing and are getting the desired effect, you can dial the Amount slider back 
down to a more reasonable value.
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5 Drag the Amount slider all the way up to 1200 cents. 

In the Pitch section, an orange ring appears around the Coarse knob that represents 
the modulation range. A white dot shows the current value for the Coarse knob, 
determined by the value sent by LFO 1. Let’s make sure LFO 1 generates a random 
signal.

6 Click LFO 1. 

7 Click the Waveform pop-up menu and choose Random. 

Each finger snap is triggered at a random pitch within a wide range of pitch modula-
tion. Let’s now bring that range to a more subtle value. 
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8 Click the Mod Matrix tab. 

9 In the LFO 1 to Pitch assignment, drag the Amount slider down to around 140 cents. 

The pitch modulation is quite subtle now, making each finger snap slightly different 
sounding than the previous one. 

10 Close the Quick Sampler plug-in window. 

11 Stop playback. 

You’ve assigned a low-frequency oscillator with a random waveform to modulate the pitch 
of the sampler in subtle amounts. That pitch randomization is just enough to make the 
sampled finger snaps sound a bit more human.

Recording Audio in Quick Sampler

You will now create a new software instrument track and record your own handclap 
sample directly into Quick Sampler. You’ll then copy the MIDI region you recorded for 
your finger snaps to the new track so that you can trigger your hand clap sample using the 
same note sequence. For this exercise, you will need to make sure the correct input device 
is selected in Logic’s audio preferences, the same way you did in Lesson 4. 

1 At the top of the track headers, click the + button (or press Option-Command-N) and 
create a new software instrument track.

2 In the instrument slot, insert Quick Sampler.
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3 Above the waveform display, click the Recorder button.

A record button appears in the middle of the waveform display. To the lower left of 
the waveform display, make sure the input where you’ve connected your microphone 
is selected from the Input pop-up menu. To use your Mac computer’s built-in micro-
phone, use Input 1. 

 To record the output of a track in real time into Quick Sampler, choose the 
desired track from the Input pop-up menu. 

 To monitor the audio signal you’re recording, click the Monitor button below 
the waveform display. 

Below the waveform display, the Record Start pop-up menu is set to Threshold. After 
you click the record button on the waveform display, Quick Sampler waits for the 
audio signal at the selected input to reach the threshold set by the slider on the Level 
Meter slider. 

4 Clap your hands a few times and, if needed, adjust the Level Meter slider.

Watch the Level Meter. The input signal level should reach above the Level Meter 
slider position when you clap your hands. Make sure the peak value displayed to the 
right of the Level Meter does not turn red, which would indicate you’re clipping the 
signal. If needed, adjust the input gain on your audio interface. 
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 When using your Mac computer’s built-in microphone, to adjust the input 
gain, choose Apple menu > System Preferences, click the Sound icon, click the Input 
button, and adjust the Input volume slider. 

5 In the waveform display, click the Record button. 

Quick Sampler is waiting for the input level to reach the threshold set by the Level 
Meter slider to start recording.

6 Clap your hands once. 

If all went well, you can see a waveform for your hand clap, and the peak detector 
to the right of the Level Meter does not go red. If your clap wasn’t loud enough, the 
recording doesn’t start, and you can clap again, louder this time. If your clap was too 
loud, the peak detector turns red; you can click the peak detector to reset it, click the 
stop button in the waveform display, and try again. 

7 In the waveform display, click the Stop button. 

The recording stops, and your sample is ready to be triggered.

8 Above the waveform display, click the One Shot button. 

Since Quick Sampler started recording exactly when you clapped your hands, the start 
marker is at the right position. 
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9 Drag the end marker toward the end of your clap sample. 

10 In the Tracks view, Option-drag the MIDI region from the Snaps track to the Claps 
track at bar 5. 

Let’s rename the new Quick Sampler track and region.

11 On the Inst 2 track (Track 3), double-click the name and enter Claps.

12 In the Tracks view menu bar, choose Functions > Name Regions/Cells by Track Name 
(or press Option-Shift-N).

The selected region on the Claps track is renamed Claps.
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13 Listen to your claps. 

NOTE ▶ If you’re happy with a Quick Sampler instrument that you made in this les-
son, save it as a patch in the Library as you learned in Lesson 3. 

14 Close the Quick Sampler plug-in window. 

Don’t hesitate to use the volume sliders in the track headers to readjust the balance 
between the drum loop on Track 1 and the Snaps and Claps tracks.

Handclaps are easy and fun to record. If you’re not alone, try sampling a group of people 
clapping together. Don’t limit yourself to finger snaps and hand claps. When Trevor Horn 
recorded the 1980s hit song “Relax” by Frankie Goes to Hollywood, he recorded the whole 
band jumping into the pool, and you can hear the resulting samples play toward the end 
of the song! Just look around you and experiment with whatever inspires you. Try stomp-
ing on plastic cups, punching cardboard boxes, shredding paper, and so on. All these 
sound effect samples can add great texture to your beats.

Creating a Quick Sampler Track Using Drag and Drop

For the intro, you will turn a vocal recording into a pad synthesizer instrument so that 
you can play melodies or chords with your keyboard. This time you will speed up the pro-
cess of importing an audio file in Quick Sampler by using the shortcuts that appear when 
dragging an audio file directly to the empty space below the track headers.

1 In the Loop Browser, search for inara.
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2 Preview Inara Lyric 03.

The loop’s key is F; however, it’s currently previewed in the project key (C). It sounds 
unnaturally low. 

3 In the Loop Browser, click the action menu at the bottom left, and choose Play in 
Original Key.

Inara’s vocals sound more natural. Let’s import that loop into Quick Sampler.
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4 Drag Inara Lyric 03 to the empty area below the track headers. 

A menu opens, giving you choices to create a new track. 

5 In the menu, choose Quick Sampler (original). 

A new software instrument track is created with Quick Sampler in the instrument 
slot, and the audio file you dragged is imported in Quick Sampler. Quick Sampler rec-
ognized multiple notes in the audio file and determined it was appropriate to use Slice 
mode; however, you’ll switch to a Classic mode in the next exercise to play a single-
note sample.

Dragging audio files from the browsers, the workspace, or the Finder to the empty area 
below the track headers saves you the tedious work of creating a new track and inserting 
the Quick Sampler plug-in every time you want to experiment with sampling something.

Looping Sample Playback to Sustain Sound

When sampling material that you want to turn into a software instrument to play melo-
dies or chords, you can loop a section of the sample. A sample loop keeps repeating until 
you release the key, allowing you to sustain the sample as long as you want.

To loop samples in Quick Sampler, you must choose Classic mode.



Sampling Single Notes  255

1 In Quick Sampler, click the Classic button. 

To the lower right of the waveform display, the root key is F2. 

2 Play an F2 note, and then play different notes on your keyboard. 

The entire vocal sample plays back, transposed according to the note you play. 
You will adjust the start and end markers so that a single note plays back. 

3 Drag the start marker to the beginning of the second note in the sample 
(around 0.600 s). 

4 Drag the end marker to the end of the same note (around 2.300 s). 

5 Play a note.

Now only the note between the start and end markers plays. If you continue holding 
down a key, the note still stops when the Quick Sampler playhead reaches the end 
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marker. Let’s create a loop section. Since you adjusted marker positions, the parameter 
display bar below the waveform display is hiding the Loop mode pop-up menu, so 
let’s close it.

You may notice that the section of the sample you chose to trigger is actually not an F 
note. You will later tune your instrument to make sure it plays the correct pitches. 

6 Below the waveform display, click the X to the left of the parameter display bar. 

The parameters revert to the default view, and you can see the Loop parameter. 

7 Click the Loop mode pop-up menu, and choose Forward. 

In the waveform display, yellow loop start and end markers let you set the loop 
boundaries. The loop section between the loop markers is yellow. 

8 At the upper left of the waveform display, click the Zoom horizontal button. 



Sampling Single Notes  257

9 Adjust the loop start and end markers.

Continue playing an F2 note while you adjust parameters in Quick Sampler. The goal 
is to have the loop sound as seamless as possible. Unless you’re lucky, you’re probably 
hearing a popping sound as the playhead skips from the loop end marker to the loop 
start marker. There are a few tools in Quick Sampler that can help that situation. 

First, you can snap your markers to zero crossings, positions where the waveform 
crosses the horizontal zero line in the middle of the waveform. 

10 Click the Snap pop-up menu and choose Zero Crossing.

Continue adjusting the loop markers. You should hear less of a popping sound. To 
make the loop sound even smoother, you can use the Alternate loop mode, which 
plays the loop alternatively from the loop start marker to the loop end marker, and 
then from the loop end marker to the loop start marker.

11 Move the pointer away from the loop markers to see the default parameters below the 
waveform display. Click the Loop mode pop-up menu, and then choose Alternate.
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Playback no longer jumps from the loop end marker to the loop start marker, making 
the loop more even. You can probably still hear some skipping at the loop start and 
end markers, but for now, try to focus on having the pitch and amplitude of the note 
sound fairly continuous. Once you’re happy with your loop section, you can further 
polish the loop using a crossfade at the loop start and end markers.

12 Drag the crossfade marker to the left to create a crossfade at the loop start and end 
points. 

Adjust the length of the crossfade so that the popping sound disappears and the loop 
sounds smooth. You may need to readjust your loop start and end marker positions. 

 In the waveform display, move your pointer in between the loop start and end 
markers and drag left or right to move the entire loop section.

Finding the right position for a sample loop can take finessing and experimentation, 
so take your time and keep trying. 

13 Play and sustain a chord on your keyboard. 

This sampler instrument still retains the original timbre of Inara’s voice, but now you 
can play it like a synthesizer on your keyboard! 

Finding the best positions in an audio file for your sample start, sample end, loop start, 
and loop end markers is the foundation of good sampling. Ultimately, not all audio files 
will give you good-sounding results when looped. As you acquire more experience, you’ll 
get better at recognizing parts of recordings that will work when sampled by listening but 
also by looking at the waveform, and you’ll get faster at editing the samples.
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Modulating Samples with LFOs and Envelopes

Now that you’ve turned audio material into a sampler instrument, you can use the modu-
lation section in the lower section of the Quick Sampler interface to affect different play-
back parameters. You will adjust the amp envelope to give your vocal a soft, slow attack 
and a long release, turning the instrument into a synthesizer pad. You will then record 
long sustained chords to lay down the background harmony while adding texture. Then 
you’ll modulate the pitch of the samples to create a vibrato effect.

At the bottom of the Amp section, the envelope display lets you control how the level 
changes over time when a sample is triggered. The selected envelope type, ADSR, stands 
for Attack, Decay, Sustain, and Release—the four segments that determine the shape of 
the envelope. 

1 At the bottom of the Amp section, move the pointer over the Attack handle (the first 
point in the envelope display).

The Attack field (A) is highlighted. 

2 Drag the point toward the right. 

 To adjust a handle numerically, drag its corresponding field vertically, or 
double-click the field and enter a value.
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To check your work, keep playing an F2 note after adjusting parameters in Quick 
Sampler. The Attack segment is slopped, and the samples fade in slowly rather than 
starting abruptly. Try different attack lengths, and finally settle for around 400 ms. 

3 At the lower right of the envelope shape, drag the Release handle to set the release to 
around 600 ms. 

The sound takes 600 ms to fade out when you release keys on your keyboard, almost 
like the sound of a reverb tail. This soft envelope is great for a pad sound. Let’s dial in 
a vibrato effect.

4 Click the Mod Matrix tab. 

5 On the first routing, click the Source pop-up menu and choose LFO 1. 

6 Click the Target pop-up menu and choose Pitch. 

7 Drag the Amount slider to around 500 cents. 
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In the Pitch section, note the orange ring around the Coarse knob, representing the 
range of pitch modulation applied by your routing.

8 Play a few notes on your keyboard. 

You can hear a very wide pitch range vibrato—it sounds like a siren! A white dot 
moves around the Pitch knob to indicate the pitch in real time. Let’s dial in a more 
reasonable pitch range.

9 In Mod Matrix, drag the Amount slider to 110 cents. 

That is still a fair amount of vibrato. When you listen to and observe classical string 
players, they often attack a note with a constant pitch at first, and start applying 
vibrato with an increasing pitch range as the note is sustained. To reproduce this 
effect, you will apply a delay to LFO 1.

10 Click the LFO 1 tab. 

11 Drag the Fade In knob to around 2500 ms. 

Before you start recording, you need to tune the instrument. When you play an F2, 
you hear a G2 instead, so let’s fix that. 
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12 At the lower left of the waveform display, set the root key to G2. 

Let’s rename the track and record some chords. 

13 On the Inara Lyric 03 track header, double-click the name and enter Synth Pads. 

14 Record one-bar long notes or chords from bar 1 to bar 5 to lay down a harmony in 
the intro section. 

You are just experimenting for now, so feel free to play any notes you want. However, if 
you can, keep all melodies and chords you record in this lesson in the key of C minor, 
and you will later be able to arrange all your tracks together into a cohesive song.

If needed, use the Quantize pop-up menu in the Region inspector to correct the tim-
ing of your performance. If some of the notes need to be edited, open the Piano Roll 
to drag the notes to the desired position or pitch. Don’t hesitate to readjust Quick 
Sampler settings to your tasting, adjusting the attack or release of the Amp envelope, 
and the amount or delay of vibrato. In the inspector, feel free to add audio effect plug-
ins to the Synth Pads channel strips. 

15 Close the Quick Sampler plug-in window. 

You have explored several methods for sampling single notes. You have imported a fin-
ger snap audio file, recorded your own hand claps, and sampled a vocal note to turn it 
into a new software instrument. In the process, you’ve gained familiarity with Quick 
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Sampler—using the Mod Matrix to route LFO to pitch, adjusting the Amp envelope, adjust-
ing sample start and end markers, and creating a loop and making sure it cycles smoothly. 

Sampling and Slicing Drums

Bringing an audio file into Quick Sampler allows for sound manipulation that opens new 
horizons. When you import a drum loop, Quick Sampler detects the transients and Slice 
mode is automatically selected. Each drum hit is separated into a slice and mapped to a 
note pitch so that it can be triggered by a specific key. 

You will use the Throwback Funk Beat 01 drum loop on Track 1 to create a new sampler 
instrument track that you can use for the song intro. You will shorten the individual slices 
with the Amp envelope, give the loop a lo-fi (low-fidelity) sound with a distorting filter, and 
reprogram the MIDI note sequence in the Piano Roll to switch around the pattern a bit. 

1 On Track 1, click the Throwback Funk Beat 01 drum loop to select it.

To import only one loop in Quick Sampler, you will temporarily turn the looping off.

2 In the Region inspector, deselect Loop (or press L).

3 Drag the Throwback Funk Beat 01 region on Track 1 to the empty area at the bottom 
of the track headers and choose Quick Sampler (Original).
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A Quick Sampler track is created, and Quick Sampler opens in Slice mode. Slice 
markers are positioned at each detected transient on the waveform display. Below the 
waveform display, MIDI note pitches are assigned to each slice, starting on C1 and 
ascending chromatically. 

 You can click the waveform display to create a slice marker, drag a slice 
marker to move it, and double-click a slice marker to delete it. 

4 Rename the new track Sliced Drums.

5 On your keyboard, play some of the notes assigned to the sample slices.

For each note you play, the corresponding slice is triggered. First, you will re-create 
the note pattern that triggers the entire original loop on the track.

6 Control-click the waveform display away from a slice marker, and choose Copy MIDI 
Pattern.

The MIDI pattern is stored in the clipboard, ready to be pasted.
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7 In the control bar, click the Go to Beginning button (or press Return).

8 In the workspace, on the Sliced Drums track, Control-click in bar 1, and choose Paste 
(or click the Tracks view to give it key focus, and then press Command-V).

A MIDI region is created on the track at the playhead position.

9 Double-click the MIDI region. 

The Piano Roll opens, and you see the pattern of chromatically ascending notes that 
trigger the successive slices in Quick Sampler.

10 At the upper left of the MIDI region in the Piano Roll, click the Play button. 

In Quick Sampler, the slices are triggered in succession, and it sounds just like the 
original loop. You are now ready to start mangling this drum loop to give it the lo-fi 
treatment that will give you an intriguing sound for the song intro. Keep the loop 
playing while you tweak its sound. First, let’s shorten the envelope of each slice to give 
the loop a muffled, cut-up sound.
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11 In Quick Sampler, on the envelope display at the bottom of the Amp section, drag the 
Decay handle to set Sustain to 0% and Decay to 20 ms. 

Each drum hit is cut up, as if it was harshly gated, giving a bouncy, staccato feel to the 
loop. You will now further distort the loop using a filter.

12 In the Filter section, click the On/Off button. 

13 Drag down the Cutoff knob to around 63%. 

Some of the high frequencies are filtered, and the loop sounds are muffled.

14 Drag up the Drive knob to around 50%. 

The filter is overdriven, and the loop sounds slightly distorted and punchy. To give 
the loop a more mid-rangey sound, you’ll use one of the band pass filters.

15 Click the Filter mode pop-up menu and choose BP 6dB Gritty. 
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The loop sounds small and lo-fi, and the kick drum is quite distorted. Use the Fil-
ter On/Off button to compare the sound of your sampled drums with and without 
filtering.

You will quickly rearrange the regions in your workspace to create an intro section.

16 Press the Space bar to stop playback. 

17 Close the Quick Sampler plug-in window. 

18 On the Slice Drums track, loop the MIDI region once so it lasts for four bars (from 
bar 1 to bar 5).

19 On the Throwback Funk Beat 01 track (Track 1), drag the Throwback Funk Beat 01 
region to bar 5.

20 In the Region inspector, select Loop (or press L).

The Throwback Funk Beat 01 region on Track 1 is looped.

21 Listen to your intro. 
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From bar 1 to bar 5, the sliced drum loop introduces the beat with a small, lo-fi sound 
punctuated by your finger snap samples. The small drums leave ample sonic room for 
the pad sound that you sampled from Inara’s voice. At bar 5, the full-sounding drum-
beat takes over. The use of a filtered drum loop in the intro makes the original drum 
loop sound bigger by contrast when it kicks in. 

Resequencing Drum Slices in the Piano Roll

On the Sliced Drums track, in Quick Sampler, each slice of the drum loop is triggered 
by different MIDI notes. That means you can now change the pitches of the notes in the 
Piano Roll to switch the beat around while keeping the same rhythm.

1 On the Sliced Drums track, click the MIDI region to select it.

The Piano Roll opens, and you see the MIDI notes that trigger the drum slices.

2 In the Piano Roll, on the keyboard on the left, click a key next to a slice number label.

The corresponding slice plays. Let’s use key commands to select different notes in the 
Piano Roll and transpose them. You will press the Left Arrow or Right Arrow key to 
select the previous or next note, and Option-Up Arrow or Option-Down Arrow to 
transpose the selected note up or down by one semitone.

3 Click the first note.

The corresponding slice plays.
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4 Press the Right Arrow key a few times.

With every key press, the next note to the right is selected, and the corresponding 
slice plays.

5 Use the Left Arrow and Right Arrow keys to select the second note.

6 Press Option-Up Arrow. 

The selected note is transposed one semitone up. 

7 At the upper left of the region in the Piano Roll, click the Play button.

The MIDI region plays in Cycle and Solo modes. You hear your new pattern with two 
successive snares at the beginning of the loop. The note is deselected.

8 Click any note to select it.

Continue using the same key commands to navigate from one note to the next and 
transpose some of the notes so that they trigger the desired slice. 

 Press Shift-Option-Up/Down Arrow to transpose a note up or down one 
octave (12 semitones). 

9 Stop playback.

10 Listen to the intro leading into the next section.
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NUMBERS
0 dBFS, 184

A
A/D (analog-to-digital) converter, 172
Adaptive Limiter plug-in, 481–482
AKAI MPC60 sampler, 237
Alchemy instrument, 141–142
Alpha Matrix Bass loop, 270, 303, 310–311
Amp Designer, 184
Amp Designer plug-in, 148–149, 162–166
Apple Loops.  

See also saving
button, 32
creating, 372–375
importing, 397–399
pitch and tempo, 174

applications, hiding, 76, 79
Applications folder, opening, 2
Arp Layers track, 160.  

See also Layered Arp track
Arrangement track, markers, 97
arrow keys.  

See keyboard shortcuts
attenuating frequencies, 455–460
audio

importing, 238–241, 380–383
recording, 188–191, 248–252

audio cells, recording, 228–231.  
See also cells; MIDI cells
audio effect plug-ins.  

See also digital audio recording
presets, 133–137
settings, 138–140
using, 281–286

audio files.  
See also stereo audio files
deleting unused, 206–208
finding, 176
matching to project key and tempo, 

399–402
audio interface and monitoring, 176–178
audio regions.  

See also Flex Time tool; regions
adding fades, 369–372
creating Apple Loops, 372–375
deleting, 190
editing timing, 413–414
joining and repeating, 367–369
slicing, 365–366
time-stretching notes, 419–423
time-stretching waveforms, 414–419

audio tracks, creating, 28, 492
Auto Gain buttons, 463.  

See also Gain values; preamp gain
Auto-Input Monitoring, 205.  

See also monitoring; Software Monitoring
automation area, toggling, 376
automation curves, drawing offline, 474–478
automation lanes, showing and hiding, 492
automation view, goggling, 487
Autopunch mode, toggling, 235, 491
aux, routing bus to, 150–153

B
balance, checking, 187–188
bars

beats in, 41
fast-forwarding, 35
keyboard shortcuts, 77–78
navigating, 490–491
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bass lines, editing, 60–65
beats in bars, 41
bit depth, 172, 207
Bitcrusher plug-in, 306–309
Bollywood Vocal Chop track, 475, 477–478
Bounce dialog, opening, 75
Bounce in Place dialog, opening, 376
bounding projects, 78, 492
Browser pane, opening and closing, 235
Browsers area, showing and hiding, 489
bus, routing to aux, 150–153

C
C#1, playing, 289
C2 note, playing, 271
Cell inspector, 226–227
cells, recording and playing, 235.  

See also audio cells; MIDI cells
Channel EQ plug-in, 108
channel strips

choosing names and icons, 68–71
configuring in Mixer, 493
keyboard shortcuts, 492–493
Lead Synth, 142
removing plug-ins, 141
soloing, 492

Chorus marker, adding, 98–99
choruses, mixing, 154–157
Classic mode, Quick Sampler, 254–255
Classic VCA button, 462
clock tick, measurement, 41
closing projects, 221
Color Bars, Track Header Components, 181
Color palette, toggling, 235, 493
Command key. See keyboard shortcuts
comping takes, 273, 278–281
compressor, quick mastering, 478–483
Compressor plug-in

quick mastering, 478–483
turning off, 147
vocals, 460–468

control bar, contents, 28–29
control surfaces, 299

Controller Assignments window, opening, 
333, 490

copying
and moving plug-ins, 161–166
regions to edit intro, 46–49
scenes in Tracks view, 387–390

count-in, MIDI cells, 224, 227
crash cymbal

on downbeat, 105
Drummer region, 84
echoing, 65
end of intro, 103, 106
in fill, 102
playing, 95
removing, 117
ringing, 106
starting, 83
stopping, 76

crossfade, Quick Sampler, 258
cycle area, adjusting, 36–40
Cycle button, 34
Cycle mode

Drummer region, 84
recording takes, 194–197
toggling, 78, 491

cycling through applications, 79
cymbals, Drummer Editor, 94–95

D
D#1, playing, 288, 292
decibels full scale, 184
delay and reverb, adding depth and distance, 

450–453
deleting

audio files, 208
audio regions, 190
loops, 22
notes, 118
patches, 168
regions, 100
selected row, 377
tracks, 8
unused audio files, 206–208
unused tracks, 295, 493
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depth and distance, adding, 450–453
depth and reverb, adding, 465–468
Deselect All, 295
deselecting all, 295
Desktop

keyboard shortcut, 32
selecting, 79

digital audio recording.  
See also audio effect plug-ins
audio interface and monitoring, 176–178
project and sample rate, 173–176
setting up, 171–173

DJ effects, 327–332
DMD (Drum Machine Designer)

importing audio, 380–383
opening, 121

Dock, adding Logic Pro X to, 3
dragged area, expanding, 78
drumbeats, programming, 342–346
Drum Kit Designer, 108–114
drum levels, adjusting using Smart Controls, 

106–108
drum performance.  

See also electronic drummer
editing, 89–95
editing intro, 100–103

drum slices, resequencing, 268–270
drum track

editing outro section, 104–106
markers in arrangement track, 95–100

drummer and style, choosing, 85–89
Drummer Editor

Complexity Range sliders, 120
Details button, 93, 119
opening, 86–87, 108
shaker, 120
undoing adjustments, 90

Drummer region, converting to MIDI, 
376, 493

drummer track, creating, 82–85
drums, sampling and slicing, 263–270.  

See also intro drum performance
duplicating scenes, 20–23
Duvid tracks, 434, 442–443, 445

E
Echo plug-in, 452
editing. See also nondestructive editing

bass lines, 60–65
drum performance, 89–95
intros, 46–49, 100–103
and loading patches, 145–149
with mouse tools, 53–56
outro section of drum track, 104–106
patches with Smart Controls, 147–149
scenes, 20–23
slice markers, 288–292

editing regions.  
See also audio regions; regions
creating song selections, 56–60
cutting to edit bass line, 60–65
ending songs, 65–67
mouse tools, 53–56

Editors area
opening, 127
showing and hiding, 489

effects, monitoring during recording,  
182–184

Electric Piano track header, selecting, 8.  
See also piano

electro-house track, creating, 118–121
electronic drummer.  

See also drum performance
customizing sounds, 121–127
electro-house track, 118–121
Hip Hop beats, 114–118

EQ display, drum levels, 108
EQ plug-in, 447–450, 454–460
ES2 instrument plug-in, 363
events and regions, repeating, 493
exporting mixes, 483–485
Extra Fly Beat track, 222–223, 226

F
F#1, playing, 290
fades, adding to audio regions, 369–372, 492
feedback

avoiding, 177, 180, 183
raising, 162
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file size, displaying, 207
files, opening, 127, 490
Finder, selecting, 76
finding audio files, 176
Flanger, accessing, 164
Flex editing tools, showing and hiding, 492
Flex Pitch, 423–429. See also pitch
Flex Time tool. See also audio regions

time-stretching notes, 419–423
timing of guitar, 414–419

Follow checkbox, multitrack projects, 91
Forward button, 34–35
frequency spectrum, equalizing, 447–450, 

454–460

G
G#1, playing, 290
Gain values, 72.  

See also Auto Gain buttons; preamp gain
Genre button, 10
global tracks

button, 96
opening, 127
showing and hiding, 489

Grid Stop button, 225
Gtr Harmonics track, 146–147
guitar

correcting timing, 414–419
effect of Microphaser, 135

H
hardware controllers, assigning, 297–298
help tags, displaying, 41–42.  

See also Smart Help
Heys track, 441–444
hidden functions, accessing, 203
hiding applications, 79
hi-hat, adding, 15, 84, 91
Hip Hop beats, creating, 114–118

I
icons, choosing, 68–71
importing

Apple Loops, 397–399

audio into DMD (Drum Machine 
Designer), 380–383

audio into Quick Sampler, 238–241
Inara loop, accessing, 252
Input Device menu, 176–177, 180
inspector

features, 28–29
toggling, 77, 489

Instrument button, 9, 13
instruments. See also software instruments

mapping plug-in parameters, 306–309
playing in Solo mode, 130–133
tuning, 186–187

intro, editing, 46–49
intro drum performance, editing, 100–103. 

See also drums
Intro Gtr channel strip, 161
I/O Buffer Size, choosing, 183
iPad control. See Logic Remote

K
key commands

assigning, 301–303
punching in and out, 198–199
using, 34–36
window, 235, 333

key focus, cycling, 11, 78, 489
keyboard shortcuts

applications, 2
audio tracks, 492
Automation lanes, 492
automation view, 487
Autopunch mode, 491
bars, 77–78, 491
beginning of project, 78, 490
bouncing regions, 78, 492–493
Browsers area, 489
channel strip, 492–493
closing projects, 221, 490
Color palette, 182, 493
Controller Assignments window, 

333, 490
converting regions to MIDI, 493
Cycle mode, 78, 491
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cycling forward and backward, 79
cycling key focus, 11, 489
cycling through applications, 495
deleting tracks, 8, 493
Deselect All, 295
Desktop, 32, 79, 495
Editors area, 127, 489
fades for audio regions, 492
Flex editing tools, 492
global tracks, 127, 489
hiding applications, 79, 495
inspector, 77
Key Commands window, 235, 333, 490
key focus, 78
Library, 85, 127, 169, 489, 494
Live Loops, 235, 493
Live Loops grid, 391, 489
Loop Browser, 77, 489
Loop parameter, 78, 492
loops to regions, 492
macOS, 79, 495
main window, 127
MIDI Out button, 495
Mixer, 77, 487, 489
Musical Typing window, 490
Mute, 492
muting and unmuting regions, 492
naming regions, 493
navigation and playback, 45, 77–78, 

490–491
notes, 376, 494–495
opening new files, 127, 490
panels, 77
panes and windows, 489–490
Piano Roll, 295, 489–490, 494–495
playhead, 491
playing projects, 77, 490
plug-in windows, 489
previewing selections, 490
project audio browser, 235
recording, 235
redoing actions, 78, 493
regions and fades, 492–493
repeating regions and events, 493

repeating selections, 78
reverting parameters, 492
rewinding bars, 490–491
rounded locators, 78, 491
saving projects, 6–7, 78, 492
screensets, 490
Select All, 78, 490, 492
selecting notes, 490
Selection-Based Processing window, 493
selections, 295, 491
setting locators, 491
Smart Controls, 127, 489
snapping, 492–493
software instruments, 492
solo operations, 130, 140, 487, 492
starting recording, 491
step sequencing, 494
stopping projects, 77, 490
Tool menu, 489
track headers, 493
track solo buttons, 429
track stacks, 158, 169, 492
tracks, 179, 210, 235, 492–493
Tracks view, 391, 489
trimming regions, 490
undoing actions, 78, 493
unused audio files and regions, 494
windows, 77
zooming, 78, 491

keys, setting, 40–46
keyword area, resizing, 9
keyword buttons, resetting, 13
kick

Drummer Editor, 94
Drummer region, 84
keyword button, 10
loop, 16

Kick & Snare slider, 91
knobs

assigning to Smart Controls, 303–306
default values, 152
displaying, 93
entering values, 156
locking, 92



502   Index

L
Latch mode, 477
latency, 183
Layered Arp track, 168.  

See also Arp Layers track
Lead Synth channel strip, 142, 150–152
lead vocals. See also vocal recordings

compressing, 460–465
depth and reverb, 465–468
processing, 453–454
shaping frequency spectrum, 454–460

Learn mode, toggling, 377
Legacy plug-ins, accessing, 164
LFO (low-frequency oscillator), 245–248
Library

accessing, 85, 136
Drum Kit Designer, 110
keyboard shortcuts, 494
loading presets, 138
opening, 127
patches, 145–147
recording MIDI, 210–211
showing and hiding, 489
Slip and Slide Lead, 154–155

Linn, Roger, 237
Live Loop cells

choosing parameters, 225–228
recording audio cells, 228–231
recording MIDI, 222–225

Live Loops
adding to scenes, 13–15
assigning pads, 298–301
browsing and previewing, 7–13
creating scenes, 23–27
duplicating scenes, 20–23
editing scenes, 20–23
keyboard shortcuts, 493
Logic Remote, 324–327
playing, 16–20
populating scenes in grid, 383–387

Live Loops grid
displaying with Tracks view, 391
locating, 4
populating scenes, 383–387

showing and hiding, 30
toggling between Tracks view, 387, 391
and Tracks view, 489

Live mode, 215
locators, setting, 491
locked screenset, customizing, 439–441.  

See also screensets
locking

knobs, 92
patches, 88–89

Logic Pro X
adding to Dock, 3
interface, 27–33

Logic Remote
controlling parameters, 476
getting help, 321–324
installing and connecting, 312–314
key command cells, 322
key commands, 321–324
mixing, 319–321
navigating projects, 314–315
playing software instruments, 315–318
Synths track, 326
triggering Live Loops, 324–327

Loop Browser
button, 4–5
opening, 77, 179
opening and closing, 4–5
showing and hiding, 489

Loop parameters, toggling, 78, 492
Loop tool, accessing, 44
loops

adding to scenes, 13–15
browsing and previewing, 7–13
chopping in take folder, 273
converting to regions, 492
deleting, 22
playing, 16–20

M
macOS, keyboard shortcuts, 79, 495
Make Up knob, 464
Marquee tool, 54–55, 102
mastering, 478–483



Index  503

merging recordings, 218–221
metronome

button, 233, 395–396
recording without, 231–234
settings, 189

Microphaser plug-in, effect on guitar,  
135–136

microphone
adjusting input gain, 250
preamp gain, 185
using, 177

MIDI (Musical Instrument Digital Interface), 
recording, 209–215

MIDI cells. See also audio cells; cells
choosing parameters, 225–228
recording, 222–225

MIDI effect plug-ins, 143–145
MIDI in Piano Roll. See also Piano Roll

creating notes, 358–360
note length and velocity, 356–358
pattern region to MIDI region, 352–353
pitch bend automation, 360–364
programming, 351
transposing notes, 354–356

MIDI keyboard
assigning buttons, 301–303
using, 297

MIDI Out button, toggling, 376
MIDI recording, correcting timing, 215–218
MIDI regions

converting to audio, 364
recording over, 218–221
recording to trigger samples, 243–245

Mixer
automating parameters, 468–469
controlling parameters, 476
offline automation, 469–474
opening, 31
recording live automation, 474–478
resizing, 72
shortcut menu, 487
showing and hiding, 489
switching between tracks area, 435–438

toggling, 77
Wide Channel Strips button, 440

mixer parameters
automating, 468–469
drawing offline automation, 469–474
recording live automation, 474–478

mixes, exporting to stereo audio files,  
483–485

mixing. See also submixes
choruses, 154–157
Logic Remote, 319–321
overview, 431
songs, 67–74
tips and tricks, 487

Modern R&B keyword button, 14
monitoring.  

See also Auto-Input Monitoring; 
Software Monitoring
adjusting levels, 185–186
effects during recording, 182–184

Monster Bass track, 223, 226
mouse tools, editing with, 53–56
Musical Typing window, opening and 

closing, 211, 490
Mute, toggling, 492

N
naming projects, 6
navigation commands, 45
New Tracks dialog, opening, 27, 235, 295, 492.  

See also tracks
No Overlap mode, 63
nondestructive editing, 207.  

See also editing
Normalize function, 483–484
notes.  

See also Quick Sampler; sampling 
single notes
creating in Piano Roll, 358–360
deleting, 118
selecting, 295, 376, 490
time-stretching, 419–423
transposing, 269, 354–356

numerical values, changing, 18
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O
Octafuzz pedal, 138–139
“One More Night” (by Maroon 5), 178
Option key. See keyboard shortcuts
Option-dragging, 46
Output Device menu, 176–177, 180
Outro Gtr tracks, 138–140
Outro marker, resizing, 99
outro section of drum track, editing, 104–106

P
pads, assigning to Live Loops, 298–301
pan knob, 72
panes, giving key focus, 11
panning in stereo field, 444–447
parallel processing

bus routing to aux, 150–153
patch merging, 154–157

parameter values
reverting to defaults, 492
scaling, 309–312

patches
deleting, 168
editing and loading, 145–149
editing with Smart Controls, 147–149
layering with summing track stacks, 

157–161
locking, 88–89
merging, 154–157
saving, 166–169
selecting and setting, 169
using from Library, 145–147

Pattern Browser, opening and closing, 377
Pattern region

adding to audio track, 346–348
converting to audio, 364
converting to MIDI, 352–353, 376, 493

patterns, clearing, 377
PCM (pulse-code modulation) files, 483
peak level meter, 184, 186
Pedal Browser, 138
Pedalboard plug-in window, 139
Pencil tool, using to create notes, 358–360
percussion, Drummer Editor, 94

phaser plug-in, inserting, 133–137
Piano, choosing, 211.  

See also Electric Piano track header
Piano Roll. See also MIDI in Piano Roll

cycling through MIDI region, 245–248
keyboard shortcuts, 494–495
resequencing drum slices, 268–270
showing and hiding, 489
transposing notes, 269

pitch, modulating for sample, 245–248.  
See also Flex Pitch

Play button, 34
playback

pitch and speed, 410–413
starting and stopping, 19, 35, 37, 101, 490

playhead, locating, 491
playing

loops and scenes, 16–20
selected cells, 235

plug-ins
accessing, 164
audio effects, 133–140, 281–286
Channel EQ, 108
choosing formats, 135
Compressor, 147
controlling parameters, 476
Drum Kit Designer, 108–114
hiding and showing windows, 169
inserting, 129
inserting on channel strips, 166
Legacy, 164
mapping Smart Controls, 306–312
Microphaser, 135–136
MIDI effects, 143–145
moving and copying, 161–166
opening, 124
Pedalboard, 139
phaser, 133–137
Q-Sampler, 124
removing from channel strips, 141
Retro Synth instrument, 155
saving settings, 166–169
showing and hiding, 489
software instruments, 140–143
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Tape Delay, 162–165
undoing parameter changes, 455

Pointer tool, 42, 376
preamp gain, controlling, 185.  

See also Auto Gain buttons; Gain values
Preferences window, 176–178
Prelisten button, 208
presets

choosing for drums, 88
finding, 183
loading from Library, 138

Project Audio Browser, 206–208, 494
Project Chooser, opening, 3
Project Settings window, 174–175
projects

bouncing, 78
building songs, 40–46
closing, 221, 490
copying regions, 46–49
creating, 1–7
editing intro, 46–49
key commands, 34–36
naming, 6
navigating and building, 33–34, 78
playing and stopping, 77, 490
repeating sections, 36–40
returning to beginning, 490
saving, 6–7, 78, 492
setting keys, 40–46
transport buttons, 34–36
zooming workspace, 49–53

punching in and out, 197–206

Q
Q-Sampler Plug-in pane, 124
quantizing 

MIDI regions, 215–218
recordings, 224

Quick Help button, 28–29
Quick Sampler. See also notes; Piano Roll; 

sampling single notes
Classic mode, 254–255
creating tracks with drag and drop, 

252–254

crossfade, 258
disabling snapping, 279
editing markers, 241–243, 288–292
Flex button, 271
Glide knob, 272
importing audio, 238–241
LFOs and envelopes, 259–263
looping sample playback, 254–258
modulating pitch, 245–248
Pitch section, 272
recording audio, 248–252
sampling and slicing drums, 263–270
Sensitivity slider, 287–288
slicing vocal recordings, 286–288
transposing samples, 270–273
triggering samples, 243–245

R
Ratio knob, 464
Record button, 34
recording

adjusting levels, 184–186
audio, 188–191
audio cells, 228–231
audio in Quick Sampler, 248–252
into Live Loop cells, 222–231
MIDI, 209–215
MIDI (Musical Instrument Digital 

Interface), 209–215
MIDI cells, 222–225
MIDI region to trigger samples, 243–245
over MIDI regions, 218–221
and playing cells, 235
scenes in Tracks view, 387–390
in selected cell, 235
into selected cells, 235
sources onto tracks, 180
starting, 235, 491
takes, 191–197, 218–221
without metronome, 231–234

recording audio
adjusting levels, 184–186
checking balance, 187–188
implementing, 188–191
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monitoring effects, 182–184
preparing tracks, 178–182
tuning instruments, 186–187

recordings, merging, 218–221
rectangle, drawing around regions, 61
redoing actions, 78, 493
Region inspector, 57
regions.  

See also audio regions; editing regions
copying to edit intro, 46–49
cutting to edit bass line, 60–65
deleting, 100
dividing, 102
keyboard shortcuts, 492–493
muting and unmuting, 492
naming by track name, 295, 493
packing into take folder, 273–278
previewing, 208
rendering with fades, 493
repeating, 493
selecting and deselecting, 36–40, 490
soloing, 491
trimming, 376, 490

Remix FX, live DJ effects, 327–332
Resize 

button, 72
pointer, 105

Retro Synth instrument plug-in, 155
reverb 

and delay, 450–453
and depth, 465–468
patch, 151–152

Reverb knob, snare, 126
Rewind button, 34–35
rounded locators, setting, 78, 491
rows, deleting, 377
ruler, displaying, 35, 203

S
sample rate

displaying, 207
explained, 172
setting, 173–176

samples, transposing and keeping synced, 
270–273

sampling single notes.  
See also notes; Quick Sampler
editing markers in waveform display, 

241–243
importing audio, 238–241
looping playback, 254–258
modulating pitch, 245–248
modulating samples, 259–263
Quick Sample tracks, 252–254
recording in Quick Sampler, 248–252
recording MIDI regions, 243–245
selecting modes, 238–241
sustaining sound, 254–258

sampling and slicing drums, 263–270
saving. See also Apple Loops

patches, 166–169
plug-in settings, 166–169
projects, 6, 78, 492
user settings and patches, 166–169

Scaling option, Parameter Mapping area, 309
scenes

copying and recording, 387–390
creating, 23–27
duplicating and editing, 20–23
playing, 16–20
populating in Live Loops grid, 383–387

screensets. See also locked screenset
recalling, 490
using, 435–441

sections, repeating, 36–40
Select All, 78, 376, 490, 492
Selection-Based Processing window, 295, 493
selections

audio effect plug-ins, 281–286
joining into regions, 376
keyboard shortcuts, 295, 376
previewing, 490
repeating, 78
transposing, 295

Send Level knob, 452
shaker, adding, 120, 122–123
Shift key. See keyboard shortcuts
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Shuffle mode, 62
slice markers, editing, 288–292
slicing audio regions, 365–366
sliders

default values, 152
entering values, 156

Smart Controls
adjusting drum levels, 106–108
Coarse Tune knob, 307
editing patches, 147–149
External Assignment area, 304
Filter Cutoff knob, 304–305
mapping to plug-ins, 306–312
opening, 127
Parameter Mapping area, 304–308
Q-Sampler Main button, 124
showing and hiding, 489

Smart Help, 323.  
See also help tags

snapping
disabling in Quick Sampler, 279
toggling, 493
turning off, 492–493

snare
Drum Kit Designer, 109
Drummer Editor, 94
Drummer region, 84

snare hit, reverberating, 26
software instruments. See also instruments

creating tracks, 210, 492
Logic Remote, 315–318
plug-ins, 140–143

Software Monitoring, 177.  
See also Auto-Input Monitoring; 
monitoring

Solo buttons, clearing or recalling, 487
Solo mode

playing instruments in, 130–133
software instruments, 140
toggling, 492

soloing regions, 491
songs. See also mixing songs

building, 40–46
creating sections, 56–60

ending, 65–67
mixing, 67–74

sound. See audio
Sounds section, padlock icon, 88
sources, recording onto tracks, 180
Space Designer window, 466
step automation, creating, 349–351
Step Sequencer 

adding pattern regions, 346–348
keyboard shortcuts, 377, 494
loading and saving patterns, 339–342
programming drumbeats, 342–346

steps
automation, 349–351
turning on and off, 336–339
turning on or off, 377

stereo audio files, exporting mixes, 483–485. 
See also audio files

stereo file, mixing down to, 75–77
Stereo Out channel strip, 153, 481
stereo position, adjusting, 71–74
Stop button, 34–35
stopping playback, 19
submixes, creating from track stacks, 432–435. 

See also mixing
Synthetic Bass keyword button, 13–15

T
take folder, packing regions, 273–278
takes

comping, 278–281
recording, 191–197, 218–221

Tape Delay plug-in, 162–165, 451
tempo, setting, 394–399
tempo changes and curves, creating, 88, 

405–407
tempo curve, 232
Threshold knob, 463
Throwback Funk Beat, 238, 263, 267, 271
timing of audio regions. See Flex Time tool
toms, Drummer Editor, 94
Tone Knob, shaker, 123
Tool menu, opening, 376
Touch mode, 477
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track headers, configuring in Tracks view, 493
track solo buttons, clearing or recalling, 429
track stacks

accessing, 158
creating, 169, 492
creating submixes, 432–435

tracks. See also New Tracks dialog
adding, 179, 210
creating, 376
deleting, 8
following grooves of tracks, 407–410
keyboard shortcuts, 492–493
naming and choosing icons, 68–71
preparing for recording, 178–182
processing with plug-ins, 161–166
soloing, 492

tracks area, switching between Mixer, 435–438
Tracks view

copying and recording scenes, 387–390
and Live Loops grid, 489
toggling between Live Loops grid, 391
using, 28–29, 31

transport buttons, using, 34–36
transport controls, assigning, 301–303
transposing

notes, 269, 354–356
selections, 295

trimming regions, 376, 490
Trippy Hat Topper, 15
tuning instruments, 186–187

U
“Umbrella” (by Rihanna), 178
undoing actions, 78, 493
unused audio files

deleting, 206–208
selecting, 235

unused tracks, deleting, 295, 493
user settings and patches, saving, 166–169

V
Varispeed, changing playback pitch and 

speed, 410–413
Verse Guitar track, 131, 146–147
Verse marker, selecting, 98–99
vocal chops

editing slice markers, 288–292
triggering and recording, 292–294

vocal recordings. See also lead vocals
slicing in Quick Sampler, 286–288
tuning, 423–429

vocals, compressing, 460–465
volume

adjusting, 71–74, 441–444
fader, 72

volume mapping, scaling, 309–312

W
Wet slider, 452
workspace, zooming, 49–53

Y
Yearning Synth Lead track header, 369, 373

Z
zooming

horizontally, 98
keyboard shortcuts, 78, 491
workspace, 49–53


	Cover
	Title Page
	Copyright Page
	Acknowledgments
	Contents at a Glance
	Table of Contents
	Getting Started
	Lesson 5 Sampling Audio
	Sampling Single Notes
	Sampling and Slicing Drums
	Transposing a Sample While Keeping It Synced to the Project Tempo
	Chopping Loops in a Take Folder
	Creating Vocal Chops
	Key Commands

	Index
	A
	B
	C
	D
	E
	F
	G
	H
	I
	K
	L
	M
	N
	O
	P
	Q
	R
	S
	T
	U
	V
	W
	Y
	Z




